
Version 5.3

Last Updated: 4 July 2013

Only for customers who have purchased the Amlib DIY/SIP2 Module.
WELCOME

Welcome to the *Amlib DIY/SIP2 5.3 Module* Installation Guide for the *Amlib DIY (Self-Service) Module*.

This is a major release updating the DIY/SIP2 module. The complete installation time is estimated at less than one (1) hour to complete.

BEFORE YOU BEGIN THE INSTALLATION...

Read the Installation Notes First

Please carefully read the entire installation guide prior to commencing the actual DIY/SIP2 release installation.

If you have any questions please contact: support-amlib@oclc.org.

**Please Note:** This installation process is for existing *Amlib* customers who have purchased the optional *DIY (Self-Service) Module*.

**WARNING:** Please make sure that the latest version of the *Amlib Client* is installed and operational on the Self Issues workstation BEFORE installing the *Amlib DIY (Self-Service) Module*.

Serial Numbers Required for Installation of Amlib Modules

The *Amlib DIY/SIP2 5.3 Module* installation requires a serial number. If you did not receive a serial key for the modules that your library has purchased you should contact OCLC (UK) Limited before commencing the upgrade.
AMLIB Supported Operating System Requirements

**PC Client**

<table>
<thead>
<tr>
<th><strong>Hardware</strong></th>
<th>• Amlib support recommend Pentium 4 CPU and above for best performance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating System</strong></td>
<td>• Windows XP, 2000, Vista, Windows 7</td>
</tr>
</tbody>
</table>
| **Memory (RAM)** | • Minimum 256 Mb for Windows XP  
• Minimum 256 Mb for Windows 2000  
• Minimum 1GB for Windows 7  
• Minimum 1GB for Windows Vista |
| **Hard Disk** | • 150 Mb Free Disk Space (if installed on local HDD) |
| **Display** | • SVGA (800x600) minimum |
| **RDBMS / ODBC Driver Software** | • Relevant Microsoft SQL Server ODBC Driver installed (minimum MDAC 2.6 and above)  
• Oracle Net8 (SQL * Net) is required |
| **Interface and Security System Link** | • SIP2 Compatible via TCP/IP or Serial Port  
• Certified vendors:  
  o 3M  
  o Raeco  
  o Talking Technologies  
  o Queensland Library Supplies  
  o STi LogiTrack RFID  
  o EnvisionWare  
  o Smart Library |

**Please Note:** To assist with email support we highly recommend that the default installation folders suggested in the following notes be retained.

For example:

- **Amlib Client software:** C:\Amlib (or D:\Amlib, E:\Amlib)
DIY SELF ISSUES & SIP2 GATEWAY PRODUCT OVERVIEW

The Amlib DIY (Self-Service) Module can be configured as:

- Patron Self Serve application (either on kiosks or PC's)
- “Middleware” Application Gateway providing a SIP2 gateway to the Amlib database for other systems such as TalkingTech iTiva telephone renewal, 3M Self Check, STi LogiTrack RFID, EnvisionWare and SmartLibrary

Amlib DIY Module as “Middleware” Gateway

For libraries that have installed Self Serve systems and software from other vendors, the Amlib DIY Module acts as “middleware” application gateway between their Vendor’s Self Serve system and the Amlib database. In this environment the Amlib DIY Module can be installed as a background application, and in most cases using the standard SIP2 protocol (SIP2 is a standard interface / protocol for integrating library management circulation functions with 3rd party vendors).

As of July 2011 the vendor systems that the Amlib DIY Module has certified integration with are:

- 3M Self Check
- Raeco Fast Track
- EnvisionWare
- QLS
- STi LogiTrack RFID
- SmartLibrary
- TalkingTech iTiva Telephone Renewal

Amlib DIY Module as Self Service Application

The Amlib DIY Module can be installed on a purpose built Public Self Serve Kiosk featuring a Windows-based PC, barcode scanner and receipt printer. One of the compatible vendors who can provide a purpose built Self Serve Kiosk is Queensland Library Supplies (QLS) which also provides a security deactivation device.

The Amlib DIY Module is a “user friendly” application, operating in an OPAC style environment where borrowers can easily issue and return their items in a secure environment whilst preventing access to Amlib modules. The Amlib DIY Module enables borrowers to “Self Issue” items by placing their borrower card then item barcode(s) under the scanner. On completion, the borrower can choose to print a receipt. The Amlib DIY Module displays...
current borrower loans as well as borrower and item alerts (for example: money owing, item not available for loan) and can prevent loan of specific item types based on system parameters. For libraries using the QLS Self Serve Kiosk, Amlib will automatically send a security deactivation code for the item.

Touch Screens can be used to minimise keyboard use at the DIY workstation.

A self-returns function is also available, so Borrowers can return items currently on loan.

Examples of Amlib DIY Deployed in Libraries:

- **Public libraries** and educational institutions using Amlib DIY on Self Serve Kiosks with facilities for printing receipts and security deactivation.

- **Special and corporate libraries** simply using Amlib DIY on a secure networked PC in their library – this is ideal when all the borrowers are organisational staff with 24-hour access to a library that is not always staffed.

- **School libraries** with library monitors (often students) issuing and returning items using Amlib DIY within a secure environment prevented from accessing the standard Amlib Circulation management functions.
INSTALL AMLIB CLIENT ON DIY WORKSTATION

The Amlib Client needs to be installed on the DIY Workstation, and connectivity to the database confirmed PRIOR to the installation of the Amlib DIY Module.

PLEASE NOTE: If the Amlib Client is already installed on the workstation you can skip this section and proceed to Install Amlib DIY (Self-Service) Module.

IMPORTANT: Please ensure that you have full read/write access to the \Amlib folder on your DIY workstation (for example: C:\Amlib) and that you are logged in with Administrative Privileges.

1. The Amlib 5.3 Client installer is available on the OCLC Website, under Setup Programs>Amlib Client: https://www.oclc.org/support/services/amlib/downloads-software-updates/version5-3/setup-programs.en.html (contact Amlib support if you require a login to this website)

2. Download the Amlib53Setup.exe and save it on your DIY workstation

3. Double-click the Amlib53Setup.exe to launch the installation Wizard – the Setup – Amlib Client screen will open displaying the Welcome message:

4. Click the Next button
5. The Serial screen will display, prompting you for valid Serial Number:

6. Enter the Serial Key supplied by OCLC (UK) Limited (case sensitive!) and then click the Next button – the Installation Location screen will display:

7. Select the folder where the Amlib Client is to be installed – a Default location will automatically display – for example: C:\Amlib

   Please Note: If you do not wish to use the Default location, click the Browse button to manually setup the location for the Amlib folder

8. Click the Next button
9. The Select Components screen will display:

![Select Components Screen]

10. Choose which components should be installed:

   a. **Modules To Install:**

      - **Amlib Staff User (Full)** – upgrades Amlib Staff Client (catalogue, circulation, etc.)
      - **Amlib Opac Only** – only upgrades the Amlib Client Server OPAC module (*only select this option if you installing on a Public Access workstation*)

   b. **Report Template Paper Format:**

      - **A4 (Australia, UK, Europe)** – installs the Amlib report templates formatted for A4 paper type
      - **Letter (USA, Canada)** – Installs Amlib report templates formatted for Letter paper type

   c. **Admin Tasks:**

      - **Modify Amlib Database (dba) Login Configuration** – only select this option if you wish to change the hidden Database Login and Password to internally connect to the Amlib database (if the RDBMS does not have user SYSADM/SYSADM)

11. Select options and click the **Next** button
12. The **Database Relational Management System** screen will display prompting for the RDBMS to be used:

![Database Relational Management System screen](image1)

13. Select from the following options:
   - Microsoft SQL Server
   - Oracle

14. If your library is using **Microsoft SQL Server** for **Amplib**:
   
d. Select **Microsoft SQL Server** and click the **Next** Button – the **Configure the SQL ini file** screen will display:

![Configure the SQL ini file screen](image2)
e. Enter the following information:

- **Enter the SQL database server name** – default display is current machine name
- **Enter the database server IP Address** – the default display is the current machine IP address
- **Enter the SQL Server ODBC driver name** – this is normally **SQL Server**, so there is no need to change that

f. Click the **Next** button

15. If your library is using **Oracle** for **Amlib**, select **Oracle** and click the **Next** Button

16. If you selected **Modify Amlib Database (dba) Login Configuration** on the **Select Components** screen at Step 7 the **RDBMS Login to be used with Amlib** screen will display:

![RDBMS Login to be used with Amlib](image)

a. You will be prompted for a hidden **Amlib Database (DBA) Login** to connect the **Amlib** SQL database:

- **AmlibNet DBA User**
- **AmlibNet DBA Password**

b. **Please Note:**

- This will be the RDBMS Login that Amlib will use as a *HIDDEN* **Amlib Database (DBA) Login** to connect the **Amlib Client** to the **Amlib** database
- An encrypted **User** and **Password** can be entered (generated using the **Amlib nopasswd.exe** utility)
- This will be stored in within the Windows\amlib.ini configuration file

c. To accept the **defaults**, click the **Next** button (this will be most customers)
17. The Select Start Menu Folder screen will display:

![Select Start Menu Folder](image1)

18. Enter a *Start* menu folder name (or leave as **Amlib Library Management System**) and click the **Next** button – the Select Additional Tasks screen will display:

![Select Additional Tasks](image2)

19. You can **unselect** the *Install desktop icons for selected components* if you DO NOT wish to install the *Amlib* icon on the desktop
20. Click the **Next** button – the **Ready to Install** screen will display with a summary of the installation tasks to be performed:

![Next Button](image)

21. Click the **Install** button – the **Installing** window will display:

![Installing Window](image)
22. When complete click the **Finish** button

![Image of Completing the Amlib Client Installation Wizard]

23. The setup Wizard will close

Installation of the *Amlib 5.3 Client* is now complete.
INSTALL AMLIB DIY (SELF-SERVICE) MODULE

Please Note: This is only for libraries that have purchased this optional module.

The Amlib DIY Module is installed in the same folder as the Amlib Client, so it is important that the latest version of the Amlib Client be installed BEFORE proceeding.

IMPORTANT: Please ensure that you have full read/write access to the \Amlib folder on your DIY workstation (for example: C:\Amlib) and that you are logged in with Administrative Privileges.

1. The Amlib DIY 5.3 Module installer is available on the OCLC Website, under Setup Programs>DIY:  
   (contact Amlib support if you require a login to this website)

2. Download the DIY53Setup.exe and save it on your DIY workstation

3. Double-click the DIY53Setup.exe to launch the installation Wizard – the Setup – Amlib DIY Module screen will open displaying the Welcome message:

   ![Welcome to the Amlib DIY Installation Wizard](image)

4. Click the Next button – the Serial screen will display, prompting you for valid Serial Number:
5. Enter the **Serial Key** supplied by *OCLC (UK) Limited* (case sensitive!) and then click the **Next** button – the **Installation Location** screen will display:

6. Select the folder where the *Amlib Client* was installed in the previous section – a Default location will automatically display – for example: **C:\Amlib**

7. Click the **Next** button – the **Select Components** window will display:
8. Choose which components should be installed:

a. Modules To Install:

   - Amlib DIY Module (New Install - Complete) – installs the Amlib DIY program files into the existing Amlib Client folder

9. Select options and click the Next button

10. The Select Start Menu Folder screen will display:

11. Enter a Start menu folder name (or leave as Amlib Library Management System) and click the Next button – the Select Additional Tasks screen will display:
12. You can **unselect** the Install desktop icons for selected components if you DO NOT wish to install the *Amlib DIY* icon on the desktop.
13. Click the **Next** button – the **Ready to Install** screen will display with a summary of the installation tasks to be performed:

![Ready to Install screen](image1)

14. Click the **Install** button – the **Installing** window will display:

![Installing window](image2)
15. When complete click the **Finish** button

![Setup - Amlib DIY Module](image)

16. The setup Wizard will close

Installation of the *Amlib DIY 5.3 Module* is now complete.
SETTING AMLIB DIY PARAMETERS

Location Codes

To maintain statistics of DIY usage, it is necessary to create a unique location for each DIY service point. For example: a site intending to use the DIY Service at three (3) separate locations will need to create three (3) separate DIY Location Code entries *in addition to* the normal branch location codes.

**Please Note:** If separate statistics are not required for DIY machines, it is not necessary to create a separate DIY location. Only create the DIY Username (see next section) and use an *existing* Location code.

1. Launch the *Amlib* client
2. Go to Main > Supervisor > Locations – the Locations screen will display

**Enter a New DIY Location**

1. Click the F1 New or F2 Insert button
2. Enter the follow details:
   a. Library Group Code
   b. Locn Code – for example: CHESEADIY
   c. Location Description – for example: Chelsea DIY Module
3. Click the F3 Save button when complete
Installation Settings (New DIY Locations Only)

Any new DIY location/s will must be set up as circulating locations.

1. Launch the Amlib client

2. Go to **Main > Supervisor > Installation** – the **Installation DEFAULT** screen will display

3. From the menu, select **Application > Choose Location** – the Choose Location screen will display:

4. Select the new DIY Location and click the **OK** button

5. The **Installation** screen will display for the selected Location – for example: **Chelsea DIY Module**

6. Select the **Other** tab

7. Scroll down to the **Location is valid for Registrations & Circulation** option – place a Y in the corresponding **Value** field

8. Click the **F3 Save** button when complete

9. Repeat steps 3 – 8 for all new DIY Locations
Creating DIY Usernames

To maintain circulation statistics through DIY, separate DIY User Names should be created for each DIY service point.

1. Launch the Amlib client
2. Go to Main > Supervisor > UserNames – the User Names table will display

Enter a New DIY User

1. Click the F1 New or F2 Insert button – a new entry will appear in the table
2. Type in the following:
   a. User Name = use one word only – for example: DIY or DIY1
   b. Location = the default login location of the DIY user – for example: CHESEADITY
   c. Circ at this Location Only = N
   d. Level = 1
3. Click the F3 Save button – the Operator Password screen will display:
4. Type in a Password and Confirm Password
5. Click the OK button when complete

Please Note: DO NOT use the F8 Choose button to assign any User permissions.
Assign DIY User Names

The DIY User Names must then be set up for use on the Opac User Names screen. A User Names must be assigned for each DIY service point.

1. Launch the Amlib client
2. Go to Main > Supervisor > Opacs > OpacUserNames – the Opac User Names table will display

Enter a New DIY User

1. Click the F1 New or F2 Insert button – a new entry will appear in the table
2. Type in the following:
   a. User Name = select a User from drop-down box – for example: DIY1
   b. Current Location Queries (Y/N) = N
   c. Web access via – leave blank
3. Click the F3 Save button when complete
4. Exit and restart the Amlib client for these settings to take effect
DIY Parameters

The parameters for controlling the DIY (Self-Service) Module allow the definition of screen messages and validation overrides. Settings in this table can control the responses made by the devices that interface with the Amlib DIY Module.

1. Launch the Amlib client
2. Go to Main > Supervisor > DIYParams – the Self Issue Parameters screen will display:

<table>
<thead>
<tr>
<th>HEADING</th>
<th>DESCRIPTION</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type S Stock B</td>
<td>Indicates whether the message refers to a Stock item or Borrower process</td>
<td>S</td>
</tr>
<tr>
<td>Borrower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Program reference – for example: borr has memo</td>
<td>Must not be altered</td>
</tr>
<tr>
<td>Reference</td>
<td>Program level reference number</td>
<td>Must not be altered</td>
</tr>
<tr>
<td>PROCEED Y/N</td>
<td>Indicates whether the loan process is to proceed (Y) or it is terminated (N). Some settings</td>
<td>Y</td>
</tr>
<tr>
<td>System MESSAGE</td>
<td>The message that the patron will see displayed when this process occurs</td>
<td>Please call at the Information Desk</td>
</tr>
<tr>
<td>Sound No</td>
<td>The sound that will be heard when this process occurs. The Sound No is linked to the System Number found in Sounds table (Main &gt; Supervisor &gt; SoundTable)</td>
<td>1</td>
</tr>
<tr>
<td>Type</td>
<td>Comment</td>
<td>Ref No</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td>B</td>
<td>&gt; max on loan</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>borr has memo</td>
<td>2</td>
</tr>
<tr>
<td>B</td>
<td>borr has overdues</td>
<td>3</td>
</tr>
</tbody>
</table>
| B    | borr owes money | 4 | Type the message you wish your patrons to read if they have overdue items on loan  
If Proceed = Y:  
Set parameter B30 to amount allowed | You have an outstanding Account. Please call at the Service Desk. |
| B    | Reregister on expiry | 5 | Type a message to instruct the patron to re-register | Please call at the Service Desk |
| B    | borr has expired | 6 | Type the message you wish your patrons to read if their membership has expired. | Please call at the Service Desk |
| B    | Pin No Required | 7 | If Proceed = Y:  
Type a message instructing the patron to enter their PIN number. For SIP2 Check pin no. supplied. | Please enter your PIN |
| B    | Opac LogOff | 8 | KEYWORD used to exit the DIY module from the Main menu. | EXIT (the first 8 chars are used for AMLIB DIY) |
| B    | OpacDelay | 9 | Type in a 3-digit figure to indicate the number of seconds for the DIY to return to Main menu. | 120 (first 3 characters are seconds to return to Main menu on AMLIB DIY) |
| B    | Borrower groups | 10 | Borrower group(s) with preceding hyphen  
If Proceed = Y:  
List of permitted groups  
If Proceed = N:  
List of prohibited groups  
(Used to set internet access for EnvisionWare) | }
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>B11</td>
<td>3m Checkin</td>
<td>Instruct the 3M device to Allow/Disallow Returns</td>
</tr>
<tr>
<td>B12</td>
<td>3m Checkout</td>
<td>Instruct the 3M device to Allow/Disallow Issues</td>
</tr>
<tr>
<td>B13</td>
<td>3m Renewals</td>
<td>Instruct the 3M device to Allow/Disallow Renewals</td>
</tr>
<tr>
<td>B14</td>
<td>3m Update status</td>
<td>Instruct the 3M device to Allow/Disallow Borrower updates</td>
</tr>
<tr>
<td>B15</td>
<td>3m Offline</td>
<td>N/A</td>
</tr>
<tr>
<td>B16</td>
<td>Amlib version</td>
<td>N/A</td>
</tr>
<tr>
<td>B17</td>
<td>Institution Id</td>
<td>Library Service Name: OCLC Library</td>
</tr>
<tr>
<td>B18</td>
<td>Library Name</td>
<td>Library Name: Chelsea Library</td>
</tr>
<tr>
<td>B19</td>
<td>Terminal Location</td>
<td>Library Location Code: 2/899 Wellington Road, Rowville 3178</td>
</tr>
<tr>
<td>B20</td>
<td>3m Screen message</td>
<td>Type the message you wish to display on the 3M device: Storytime every Thursday at 10.00am</td>
</tr>
<tr>
<td>B21</td>
<td>3m Print message</td>
<td>Type the message you wish to display on the 3M device: Renew your item online at <a href="http://www.amlib.com.au">www.amlib.com.au</a></td>
</tr>
<tr>
<td>B22</td>
<td>3m Status Proceed</td>
<td>Type the message you wish to display on the 3M device</td>
</tr>
<tr>
<td>B23</td>
<td>Amlib Main Image</td>
<td>Type in the path of the Main screen image: C:\amlib\mm.bmp</td>
</tr>
<tr>
<td>B24</td>
<td>Amlib Borr Image</td>
<td>Type in the path of the Patron card entry screen image: C:\amlib\bm.bmp</td>
</tr>
<tr>
<td>B25</td>
<td>Amlib Item Image</td>
<td>Type in the path of the item entry screen image: C:\amlib\sm.bmp</td>
</tr>
<tr>
<td>B26</td>
<td>Amlib Allow Print</td>
<td>If Proceed = Y: Press here to Print Will enable a Print button to print all items on loan. Use this message box to insert text within the Print button (Report template name: SILOAN.QRP)</td>
</tr>
<tr>
<td>B27</td>
<td>Wand Barcode Desc</td>
<td>Type the message you want the patron to read to instruct them to enter their member number in the text box: Enter your Library Card here</td>
</tr>
<tr>
<td>B28</td>
<td>Print New Items List</td>
<td>If Proceed = Y: Print New Item only Will enable a Print button to print only items issued in the session. Use this message box to insert text within the Print button (Report template name: SILOAN.QRP)</td>
</tr>
<tr>
<td>B</td>
<td>Borrower button text</td>
<td>29</td>
</tr>
<tr>
<td>B</td>
<td>Borrower fine limit</td>
<td>30</td>
</tr>
<tr>
<td>B</td>
<td>Allow Renewals in Amlib</td>
<td>31</td>
</tr>
<tr>
<td>B</td>
<td>Invalid borrower barcode</td>
<td>32</td>
</tr>
<tr>
<td>B</td>
<td>ADULT Borrower type(s) for internet access</td>
<td>33</td>
</tr>
<tr>
<td>B</td>
<td>CHILD Borrower type(s) for internet access</td>
<td>34</td>
</tr>
</tbody>
</table>

Stockitem (S)

<p>| S | Item already on loan | 1 | Type the message you wish your patrons to read if an item already on loan is being re-issued | This item may not be issued. Please take it to the Service Desk. |
| S | Item has memo | 2 | Type the message you wish your patrons to read if the item has a memo attached | This item may not be issued. Please take it to the Service Desk. |
| S | Item has alert | 3 | Type the message you wish your patrons to read if an alert is attached to the item | This item may not be issued. Please take it to the Service Desk. |
| S | Item has alien reserve | 4 | Type the message you wish your patrons to read if the item is reserved for another borrower | This item may not be issued. Please take it to the Service Desk. |
| S | Cancel item charge | 5 | Type the message you wish the patron to read if the issue charge is to be cancelled | Item charge cancelled |
| If Proceed = Y: Auto charge will be removed on check-in |
| S | Stop issue on charge | 6 | Type the message you wish the patron to read if a charge is applicable for the issue | This item may not be issued. Please take it to the Service Desk. |
| S | No loan parameter | 7 | Type the message you want the patron to read if the item has no loan parameter. | This item may not be issued. Please take it to the Service Desk. |</p>
<table>
<thead>
<tr>
<th></th>
<th>No renewal parameter</th>
<th>8</th>
<th>Type the message you want the patron to read if the item has no renewal parameter.</th>
<th>This item may not be renewed. Please take it to the Information Desk</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Renewal limit exceeded</td>
<td>9</td>
<td>Type the message you want the patron to read if the item exceeds the renewal limit.</td>
<td>This item may not be renewed. Please take it to the Information Desk</td>
</tr>
<tr>
<td></td>
<td>Item not for loan</td>
<td>10</td>
<td>Type the message you want the patron to read if the item is not for loan.</td>
<td>This item may not be issued. Please take it to the Information Desk</td>
</tr>
<tr>
<td></td>
<td>Renew overdue item</td>
<td>11</td>
<td>Type the message you want the patron to read if the item to be renewed is already overdue.</td>
<td>This item may not be renewed. Please take it to the Information Desk</td>
</tr>
<tr>
<td></td>
<td>Max items reached</td>
<td>12</td>
<td>Type the message you want the patron to read if the item exceeds the patron loan limit.</td>
<td>This item may not be issued. Please take it to the Information Desk</td>
</tr>
<tr>
<td></td>
<td>Exceeded form limit</td>
<td>13</td>
<td>Type the message you want the patron to read if the item exceeds the patron loan limit for a Form Code.</td>
<td>This item may not be issued. Please take it to the Information Desk</td>
</tr>
<tr>
<td></td>
<td>Magnetic Media</td>
<td>14</td>
<td>If Proceed = N: Will disallow the loan if you have Stockitem Form Codes that are not to be issued. These need to be defined here, separated with dash. For example: to prevent Videos (Form Code = VI) and Audio Cassettes (Form Code = AC), enter -VI-AC in this field along with a message to inform the patron.</td>
<td>-VI-AC These are sensitive items and cannot be lent via DIY</td>
</tr>
<tr>
<td></td>
<td>Magnetic Media</td>
<td>15</td>
<td>If Proceed = Y: Will allow the loan if you have Stockitem Form Codes that can be issued. These need to be defined here, separated with dash. For example: to allow CD’s (Form Code = CD) to be loaned enter -CD in this field along with a message to inform the patron.</td>
<td>-CD These are sensitive items and can be lent via DIY</td>
</tr>
<tr>
<td></td>
<td>Not to be removed</td>
<td>16</td>
<td>If Proceed = N: Will prevent the loan. If you have Stockitem Form Codes that cannot be issued. These need to be defined here, separated with a dash. For example: to prevent Reference books (Form Code = RE) from being issued enter -RE in this field along with a message to inform the patron.</td>
<td>-RE These are Reference items and cannot be lent via DIY</td>
</tr>
<tr>
<td>S</td>
<td>Default loan period</td>
<td>17</td>
<td>If using DIY offline you can define the loan period here. For example: if the loan period is 21 days enter –21 in this field.</td>
<td>-21</td>
</tr>
<tr>
<td>S</td>
<td>Item button text</td>
<td>18</td>
<td>If Proceed = N: Will trigger a dialogue box to appear after every issue. Use the message box type the message that will appear in the dialogue box. If Proceed = Y: Will not trigger a dialogue box</td>
<td>Issue successful. Press Enter to Continue</td>
</tr>
<tr>
<td>S</td>
<td>Allow returns in Amlib</td>
<td>19</td>
<td>If Proceed = Y: Will enable a returns function via a Returns button located on the DIY Main screen</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>Print return item list</td>
<td>20</td>
<td>If Proceed = Y: Will enable a Print button to print returned items in the session. Use this message box to insert text within the Print button (Report template name: $SILOAN.QRP)</td>
<td>Print Returns List</td>
</tr>
<tr>
<td>S</td>
<td>Return reserved item</td>
<td>21</td>
<td>If Proceed = Y: Will alert user with message</td>
<td>The returned item is on reserve to another borrower</td>
</tr>
</tbody>
</table>

To alter a system message:

1. Any of the System MESSAGEs can be changed to suit your Library service – for example: the message “Please call at the Information Desk” can be changed to something more meaningful

2. Click the F3 Save button when complete – a prompt will appear with the following message:

   A new DIY.INI file has been created for use with DIY Systems.

3. Click the OK button

**IMPORTANT:** Editing the Self Issues Parameters table will generate a new DIY.ini configuration file. The updated DIY.ini configuration file MUST be copied to the Amlib Client folder (for example: C:\Amlib) on the Amlib DIY Self Service workstation. This file is only used when the Amlib DIY Module is used in offline mode – i.e.: not connected to the Amlib database.
Please Note: When using *Amlib DIY Module* in “Offline Mode” (i.e. not connecting to the *Amlib* database) the *Issue* and *Return* screens are not displayed. Instead, the Offline “select file” window and the *Amlib* offline capture screens are displayed. In this case the Location field and other parameters are read from the standard *Amlib offline.ini* file and *DIY.ini* configuration files so that some processing rules may be established. (The *offline.ini* file is the same file used in the *Offline Circulation* module).

**Setting Up Additional DIY Applications**

It is possible to run individual DIY applications using different parameters. This is especially useful at sites that incorporate the DIY with another vendor product (*Talking Technologies, LogiTrack*) as a backend and at the same time use DIY in the general circulation environment. Both applications may require some parameters to differ in order to perform effectively. Up to nine different sets of parameters can be created.

1. Launch the *Amlib* client
2. Go to **Main > Supervisor > DIYParams** – the *Self Issue Parameters* screen will display:

![DIY Parameter Screen](image)

3. Click the **F1 New** button – a prompt with the following message will display:

   *Are you sure you really want to create a new set of DIY parameters
   Continue with creation?*

   ![DIY Create Prompt](image)

4. Click the **Yes** button – a prompt with the following message will display: **A new DIY.INI file has been created for use with DIY Systems.**
5. A new set of parameters have now been created – the Parameters for DIY will now read **2 of 2**:

6. The parameters can be edited as required
TESTING LOGIN TO AMLIB

The connection of the *Amlib DIY Module* can to the *Amlib* database can be tested as follows:

1. On the DIY Workstation, select the *DIY Self Issues* icon from the *Amlib* program group in the *Start* menu (alternatively: double-click the *DIY Self Issues* icon on the desktop)

2. The *Amlib Self Service* screen will display:

   ![Welcome to Amlib Patron Self Service](image)

   - **Update Options**
     - ~Online to Database~
     - Save to Offline File

   - **Transaction Types**
     - ~Issue Session [CheckOut]~
     - ~Return Session [CheckIn]~

   - **Communications**
     - Serial
     - TCP/IP

   - **Vendor**
     - FastTrack [Raeco]
     - Self Check [3M]
     - Talkingtech
     - EnvisionWare
     - Sti Logitrack
     - Smart Library
     - D.I.Y. [Amlib + Security]
     - D.I.Y. [Amlib No Security]

3. Select the following options:
   a. **Update Options**:
      - ~Online to Database~
   b. **Transaction Types**:
      - ~Issue Session~
   c. **Communications**:
      - Serial
   d. **Vendor**:
      - D.I.Y. (Amlib No Security)

4. Click the **OK** button

This will log directly to *Amlib* without connecting to the 3M or Raeco Self Issue workstations.
5. The Database selection screen will display:

![Database Selection Screen]

6. Select the database you wish to connect to (for example: Live Database) and click the OK button.

7. The Self Issue Login screen will display:

![Self Issue Login Screen]

8. Type in a valid Opac User Name and Password (see Assign DIY User Names above) and click the OK button.

9. The Self Issue Terminal Confirmation screen will display:

![Self Issue Confirm Screen]

10. Select the DIY Location (for example: Chelsea DIY Module – DIY1) and click the OK button.
11. If there is more than one DIY Parameter Set available (see Setting Up Additional DIY Applications above), the Parameter set screen will display:

![Parameter set screen]

12. Select the appropriate Parameter set and click the OK button.

13. The DIY Self Issue screen will display:

![DIY Self Issue screen]

14. Click the F1 Start button to begin.

**Please Note:** The bitmap on the first DIY Self-Issues processing screen above can be customised for each library.

- The password in DIY Self Issue Parameters option B8 (see DIY Parameters above) can be used on the Main menu to Exit the Amlib DIY Module.
AMLIB DIY AS A SELF-SERVICE APPLICATION

Images

There are three (3) images in the DIY module. The images can be bitmaps (.bmp) or .jpg and can be edited using picture-editing software – for example: Paint or Adobe Photoshop.

- BM.bmp (or BM.jpg)
- MM.bmp (or MM.jpg)
- SM.bmp (or SM.jpg)

The images to be used are set in the Self Issue Parameters screen in the Amlib client (see DIY Parameters above):

1. Main Menu image: MM.bmp (Type: B23)
2. Borrower Details Image (requesting borrower barcode): BM.bmp (Type: B24)

![Borrower Details Image](image)

3. Stockitem Details Image (requesting stockitem barcode): SM.bmp (Type: B25)

![Stockitem Details Image](image)

**Template**

- On-loan print template for DIY

The template `$SILOAN.QRP` may be customised to include the library name, address and telephone number. The `$SILOAN.QRP` template is used for All Issues, New issues and Print Returns function (Types: B26, B28, S20 in the Self Issues Parameters screen – see DIY Parameters above).

The RepWin application can be used to customize the template.

![RepWin Application](image)
Using DIY

Self Issues

- The password set in the Self Issues Parameters screen (B8) can be used on the Main Menu screen to exit the Amlib DIY Module
AUTOMATING DIY LOGIN

The login process for the Amlib DIY Module can be automated by configuring the default settings in the Amlib.ini configuration file located in the Windows folder (normally C:\Windows or C:\Winnt).

### SECTION / KEY | DESCRIPTION
---|---
[DIY] | Required Section Name in the Amlib.ini file
Online=Y | Specifies that application will connect online to the Amlib database (default = Y)
Issues=Y | Identifies whether issue (Checkout) function is available (default = Y)
Connection=IP | Specifies whether connection interface between Self Issues Kiosk and Amlib DIY Module is via TCP/IP or direct Serial connect (for example: RS-232)
  - Connection=IP
  - Connection=SERIAL
  - (Default is SERIAL)
Port=6001 | IP Port No for connection interface (must be > 2000 and < 10000) Default is 6001. Always use a different port for each device.
Vendor=3M | Type of device Amlib DIY Module is connecting to (default =3M). Choices are:
  - Vendor=PI (Amlib Direct)
  - Vendor=AMLIB (Amlib with QLS security)
  - Vendor=3M (this is the default option. Also use for Overdrive)
  - Vendor=RAECO
  - Vendor=TALKINGTECH (iTiva from Talking Tech)
  - Vendor=STI (STI RFID)
  - Vendor=ENVISIONWARE
  - Vendor=SMARTLIBRARY (use for FE Technologies)
AutoLogin=Y | Specifies whether Amlib DIY Module is to automatically login to the Amlib database (default = N)
AutoConnect=Y | Specifies whether the Amlib DIY Module is to connect automatically to port specified and wait for a connection from the Self Issues device (default = N)
Database=Live | Specifies which Amlib database to connect to. Choices are:
  - Database=Live
  - Database=Test
DefaultUser= | Amlib DIY Module login to use, together with optional encrypted password. The Amlib DIY Module login must be created within the Opac UserNames screen within the Supervisor module, and if you have multiple location/branches you will need to have a separate login for each location. Details on how to specify the password can be found later in this document.
ParameterSet=2 | Specifies which Amlib DIY Parameter Set to use from the Supervisor module (only required when more than DIY parameter set).
Logging=Y | Specifies whether logging to diy.log will automatically occur on startup.
CONFIGURE AS A SIP/SIP2 GATEWAY TO LISTEN TO TCP/IP REQUESTS FROM MULTIPLE SOURCES

**Question:** How do I set the Amlib DIY Module to listen for requests from multiple sources?
*(for example: from 3M Self Check Workstations, and from TalkingTech Telephone Renewals)*

**Answer:** The *Amlib DIY Module* needs to have PC (or server) configured to listen for TCP/IP requests (using SIP/SIP2 protocol) with a separate Amlib DIY Instance running for EACH source.

- **Example 1:** *Windows 2000/XP* PC at Council server room with multiple *Amlib DIY Module* instances installed and configured, with each instance listening on a different TCP/IP Port for requests from 3rd party application

- **Example 2:** *Windows 2000/XP* PC at Library Branch (for example: dedicated Reports PC, or Circulation Check-in PC) with multiple *Amlib DIY Module* instances installed and configured, with each instance listening on a different TCP/IP Port for requests from 3rd party application

The advantage of example 2 above is that it will reduce network traffic within the Council/Library network, and improve response times to the Oracle database, as well as easy for the local library branch to restart the *Amlib DIY module* if required.

**Summary on how to configure Amlib DIY Instances on a single Server/PC:**

1. Ensure the `C:\Windows\amlib.ini` configuration file **DOES NOT** contain a section `[DIY]` or any parameters (since this will overwrite each individual *Amlib DIY Module* instance settings)

2. Install the *Amlib Client* on the server/PC (for example: in `C:\Amlib` folder)

3. Install the Amlib DIY Module on the server/PC (for example: in `C:\Amlib` folder)

4. Configure the `amlib.ini` configuration file located in the client folder above (for example: `C:\Amlib\amlib.ini`) and add the section `[DIY]` with the required settings (see example below)

5. Create a new folder `C:\AmlibDIY2` for the 2nd *Amlib DIY* instance, and copy the `diya.exe` file (`C:\Amlib\diya.exe`) into the `C:\AmlibDIY2` folder, and create a new `amlib.ini` file with the required DIY settings (see example below)

6. For any additional instance repeat previous step (except name folder as `C:\AmlibDIY3`, etc.)

See examples next page.
Example 1: *Amlib DIY* `amlib.ini` Settings (in `C:\Amlib`) to listen as *Amlib/3M Gateway* via **Port 6001** for *3M Self Check* Requests for Bowen Library:

```
[DIY]
Online=Y
Issues=Y
Connection=IP
Port=6001
Vendor=3M
AutoLogin=Y
AutoConnect=Y
Database=Live
ParameterSet=1
DefaultUser=BOWENSC
DefaultPrefix=Live
```

Example 2: *Amlib DIY* `amlib.ini` Settings (in `C:\AmlibDIY2`) to listen as *Amlib/TalkTech Gateway* via **Port 6002** for *TalkingTech* LINE 1 Requests:

```
[DIY]
Online=Y
Issues=Y
Connection=IP
Port=6002
Vendor=TALKINGTECH
AutoLogin=Y
AutoConnect=Y
Database=Live
ParameterSet=2
DefaultUser=TALK
DefaultPrefix=Live
```

Example 3: *Amlib DIY* `amlib.ini` Settings (in `C:\AmlibDIY3`) to listen as *Amlib/TalkTech Gateway* via **Port 6003** for *TalkingTech* LINE 2 Requests:

```
[DIY]
Online=Y
Issues=Y
Connection=IP
Port=6003
Vendor=TALKINGTECH
AutoLogin=Y
AutoConnect=Y
Database=Live
ParameterSet=2
DefaultUser=TALK
DefaultPrefix=Live
```

**Please Note:** In the above example a separate *Amlib DIY* instance is required for each *TalkingTech* Incoming Telephone Line.
SPECIFY PASSWORDS FOR AUTOLOGIN

**Question:** How do I specify the password for the AutoLogin within the [DIY] section of the *amlib.ini* configuration file (especially if running multiple *Amlib DIY Module* Instances with each instance having a different username/password)?

**Answer:** If you are only running one (1) instance of *Amlib DIY Module* on a PC and using the same DIY login and password, then the *Amlib DIY Module* will remember the password the next time you login via DIY. However, if you are running multiple instances of the *Amlib DIY Module*, each with its own login you will need to specify the each password if you wish to use the DIY AutoLogin feature.

- Within the [ClientFolder]\amlib.ini (for example: C:\Amlib\amlib.ini) configuration file you can append the encrypted password to the **DefaultUser=** keyword. The format of the keyword is:
  - `DefaultUser=Login,EncryptedPassword` – for example: `DefaultUser=PENNSC,tU+Ln>sZ;64p\ <|0ry.>Rbk"` [Bh

**Question:** How do I find out what the encrypted password is for each of my different DIY Logins?

**Answer:** Use the following steps:

1. Login to the *Amlib DIY Module* with required DIY Login and Password
2. Open the [Windows]\amlib.ini configuration file (for example: C:\Windows\amlib.ini)
3. Go to the section [DIY] and look for the keyword `LastLive=`
4. Copy the encrypted password of the `LastLive=` keyword (will be the **BOLD** part of the following example: `LastLive=PENNSC,tU+Ln>sZ;64p\ <|0ry.>Rbk"` [Bh
5. Open the required [ClientFolder]\amlib.ini (for example: C:\Amlib\amlib.ini) configuration file and append the password to the **DefaultUser=** keyword. The format of the keyword is `DefaultUser=Login,EncryptedPassword` – for example: `DefaultUser=PENNSC,tU+Ln>sZ;64p\ <|0ry.>Rbk"` [Bh

Please ensure there is a comma (,) between the Login and Password

Repeat the above steps for EACH DIY Login specified in each *Amlib DIY* Client Folder (C:\Amlibdiy2, C:\Amlibdiy3, etc.).

**IMPORTANT:** You will need to repeat this process if you change your DIY passwords!
TROUBLESHOOTING TIPS

The first step in troubleshooting problems that you may be experiencing with *Amlib* (*Client* or *NetOpacs*) connecting to the database is to first check the following:

- Can you connect to the *Amlib* database using the *Amlib Client* on the server?
- Can you connect to the *Amlib* database using the *Amlib Client* from another workstation?

The next step is to try and isolate the problem and ensure that the problem is not due to the hardware, network or firewall.

Check Communication to Database Server using Microsoft Port Query

*Microsoft Port Query* is an easy to use tool that enables you to test whether you can connect from a Workstation (or Web Server) to the database server, and whether the RDBMS is listening for connection requests.

1. Launch the *Microsoft Port Query* program, which will be located:
   - *Amlib Client*: C:\Amlib\Utility\PortQryUI\portqueryui.exe
   - *NetOpacs*: C:\Netopacs\Utility\PortQryUI\portqueryui.exe
   - *ZServer*: C:\Zserver\Utility\PortQryUI\portqueryui.exe

   **Please Note**: replace C:\Amlib or C:\Netopacs with the actual path where the applications have been installed
2. Enter the Destination IP address of the database server used when installing Amlib (for example: tardis, 127.0.0.1, etc.)

3. Select the Manually input query ports option

4. Enter the Ports to query:
   - If using Microsoft SQL Server, enter: 1433
   - If using Oracle, enter: 1521 (older versions of Oracle may be using: 1525)

5. Protocol: TCP

6. Then click the Query button to start the search

Query Results

1. If the Query result is LISTENING (for example: TCP port 1433 (ms-sql-s service): LISTENING) then this indicates:
   - the Workstation (or Web Server) can communicate to the database server OK
   - you will need to proceed to the next level of Amlib troubleshooting to identify the problem you are experiencing

2. If the Query result is NOT LISTENING (for example: TCP port 1433 (ms-sql-s service): NOT LISTENING) then this indicates:
   - the Workstation (or Web Server) is unable to communicate to the RDBMS on the database server

   You should refer this problem to your organisation’s database or network administrator to follow up.

   - Possible reasons why it is unable to communicate to the RDBMS on the database server:
     i. the database server is not running
     ii. the database server is disconnected from the network
     iii. the workstation (or web server) is disconnected from the network
     iv. there is a problem with the network (for example: switch is faulty, DHCP is not running, etc.) or network configuration
     v. the RDBMS is not running on the database server (check in Windows Services whether the RDBMS (Microsoft SQL Server or Oracle) is running
     vi. the enterprise firewall is preventing connectivity via this Port
     vii. the workstation firewall (for example: Windows XP Service 2 firewall) is preventing connectivity via this Port
     viii. there a problem with hardware (for example: network card in either database server, workstation or web server)
3. If the Query result is FILTERED (for example: TCP port 1433 (ms-sql-s service): FILTERED) then this indicates:
   - the enterprise firewall is preventing connectivity via this Port
   - the workstation firewall (for example: Windows XP Service 2 firewall) is preventing connectivity via this Port

You should refer this problem to your organisation’s database or network administrator to follow up.

Next Level of Amlib Troubleshooting

- **Message:** Cannot connect to Amlib database.

A message “Cannot connect to remote Amlib database” is displayed if the PC is unable to connect via the WAN (or if sql.ini is not correctly configured):

![Error Message](image)

The following steps can be used to track down the problem:

1. Review the RDBMS error message displayed on the Cannot connect screen – for example: the above example refers to Error No. 20016...SQL Server does not exist... This is a SQL Server error and should be following up with your database administrator (the error number is not an Amlib error number)

2. Can the PC connect to the database server? – refer to the previous section Check Communication to Database Server using Microsoft Port Query above

3. If step 2 above is OK, then ensure that you DO NOT have any ODBC Data Sources with the same name as the database (for example: make sure there is NOT an ODBC data source called AMCAT, AMLIB, AMLOCAL, AMSTATS or AMWEB)
   - In Windows XP, go to: Control Panel > Administrative Tools > Data Sources (ODBC), and check within the User DSN, System DSN or File DSN tabs
   - In Windows Vista/7, go to: Control Panel > System and Security > Administrative Tools > Data Sources (ODBC), and check within the User DSN, System DSN or File DSN tabs
4. If step 3 above is OK, then identify whether the **SQL.ini** is correctly configured or whether there is a connection error – to test:

- Launch the *Amlib Upgrade (\Amlib\upgrade.exe)* SQL interface application
- From the menu, select **File > Advanced Login** – the *Advanced Login* screen will display:

  ![Advanced Login Screen](image)

  - Enter the login details:
    - **Login name**: SYSADM
    - **Password**: SYSADM
    - **Database**: AMCAT
  - Click the **OK** button
    - If Upgrade is able to connect OK to the selected database and will return to the main Upgrade screen and display the username and database
• For SQL Server RDBMS: repeat the above Advanced Login step for each other database (AMLIB, AMLOCAL, AMSTATS and AMWEB) to see whether the problem is due to being unable to connect to only 1 of the databases

If Upgrade is unable to connect to the selected database then take a detailed copy of the displayed error message (for example: press [Prt Scn] on your keyboard and Paste into a MS Word document) and contact Amlib Support for further assistance:

It is also suggested that you take a note of the Error number and research with the RDBMS vendor the explanation and resolution for the Error number:

• For Microsoft SQL Server 2008 R2: [http://support.microsoft.com](http://support.microsoft.com)
• For Oracle: [http://www.oracle.com/support/index.html](http://www.oracle.com/support/index.html)

Some of the reasons that the Upgrade.exe is unable to connect to the selected database:

• The database does not exist within the RDBMS (for example: if an administrator had deleted the AMCAT database)
• The administrator had moved the Amlib databases to another server
• The database server has insufficient disk space
• The Amlib SQL.ini configuration file (located in the C:\Amlib folder for the Amlib Client, or C:\Netopacs for the NetOpacs module) is not correctly configured – for more information on this refer to the separate document relating to SQL.ini Client Communication and Configuration File
• For libraries using Oracle RDBMS – the Oracle 10 Client is not correctly configured (using the Oracle TNSPING utility on the Workstation to test)
• For libraries using Microsoft SQL Server – an old version of the Windows MDAC (ODBC) drivers are installed

5. If step 4 above is OK, then perhaps the Amlib database connection settings held in \[windows]\amlib.ini are incorrect (these are different to the DIY Default User and Login settings)

• For more information on Amlib database connection settings refer to Appendix A: Amlib Database Connection Settings
Advanced Support Note for Oracle Version 10 Client

Unable to Retrieve Rows from the database Amlib support has identified some problems that some workstations and web servers using Oracle 10 Client and Amlib:

- The PCs would “hang” when trying to login to Amlib and display a message that it is unable to connect to the database
- When trying to using SQLTalk to troubleshooting, you can connect to the database but SQLTalk would hang when trying to retrieve rows from any tables (for example: select * from borrower)

Action Taken:

- In the Windows registry (regedit) within HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ create a new String value of ORAOCI with a value of ORACLIENT8.DLL
- If problem still occurs rename or remove the file C:\Amlib\OCIW32.DLL especially since this file will already exist in the Oracle Client installation folder.

• Technical Notes from Centura Using OCIW32.DLL: In CTD 1.1.1, the Oracle router utilizes an Oracle DLL named OCIW32.DLL. As the Oracle documentation describes the function of this library, it uses the ‘variable’ ORAOCI to determine the name of the Oracle client DLL to load. If ORAOCI is not defined, OCIW32 will search through a predefined list of known Oracle client DLL names (most recent to least recent releases) until it either finds one or exhausts the known names and returns an error. The version of OCIW32.DLL that ships with CTD has a predefined list of Oracle client DLL names which predates the release of Oracle 8. If a particular workstation has only Oracle 8 files installed, the Oracle client DLL will not be found; this will have a name like ORA803.DLL. To correct this problem, either delete or rename the OCIW32.DLL that comes with CTD so that the Oracle router will load the OCIW32.DLL released by Oracle which knows about the Oracle 8 client DLL names, or define the variable ORAOCI to point to ORA803.DLL (or whatever name is current). This variable is located in the registry, and the CTD release notes contain instructions on how to locate it and set its value.
Testing Whether Amlib DIY Listening for SIP2 Requests

To test whether Amlib DIY Self Issues is listening for SIP2 Requests (assuming you have setup DIY as a Middleware “Gateway” listening for SIP2 requests).

1. Launch the Microsoft Port Query program, which will be located:
   - *Amlib Client:* C:\Amlib\Utility\PortQryUI\portqueryui.exe
     
     **Please Note:** replace C:\Amlib with the actual path where the application has been installed

2. Enter the Destination IP address of the Amlib DIY workstation/server configured to listen for SIP2 requests (for example: *tardis, 127.0.0.1, localhost,* etc.)
3. Select the Manually input query ports option
4. Enter the TCP Port
5. Enter the TCP Port you have configured Amlib DIY to listen for SIP2 Requests in *Ports to query*:
   - such as *6000* or *6002* (you can also enter a range of port numbers if required)
7. Then click the *Query* button to start the search
Query Results

1. If the Query result is **LISTENING** (for example: TCP port 6000 (unknown service): LISTENING) then this indicates:
   - the Workstation (or Web Server) IS listening for SIP2 requests on the select port

2. If the Query result is **NOT LISTENING** (for example: TCP port 6001 (unknown service): NOT LISTENING) then this indicates:
   - the Workstation (or Web Server) is NOT listening for SIP2 requests on the select port

You should refer this problem to your organisation’s database or network administrator to follow up.

Possible reasons why it is unable to listen for SIP2 requests:

- the **Amlib DIY Module** is not correctly configured
- the correct **amlib.ini** Configuration File entries have not been made OR there is a conflict between the C:\Amlib\amlib.ini and C:\Windows\amlib.ini
- the workstation (or server) is not running or is disconnected from the network
- there is a problem with the network (for example: switch is faulty, DHCP is not running, etc.) or network configuration
- the enterprise firewall is preventing connectivity via this Port
- the workstation firewall (for example: *Windows XP Service 2 firewall*) is preventing connectivity via this Port

3. If the Query result is **FILTERED** (for example: TCP port 6001 (unknown service): FILTERED) then this indicates:
   - the enterprise firewall is preventing connectivity via this Port
   - the workstation/server firewall (for example: *Windows XP Service 2 firewall*) is preventing connectivity via this Port

You should refer this problem to your organisation’s database or network administrator to follow up.

**Amlib DIY with Raeco Fast Track**

*Raeco Fast Track* self-issue systems use a *Visual Basic* interface file called **MSCOMM.VBX** to communicate to library systems such as *Amlib*. This file should be located in the C:\Windows (Windows 95/98/Vista/7) or C:\Winnt (Windows NT/2000) folders. If the **Amlib DIY Module** is unable to connect to *Raeco Fast Track* then you should copy **mscomm.vbx** from your *Amlib Client* software folder (for example: C:\Amlib) to your *Windows* folder.
SIP2 Protocol Troubleshooting

To troubleshoot problems with vendor devices which use the SIP/SIP2 protocol a LogFile checkbox is available on the connection window. All SIP/SIP2 packets sent and received by DIY are written to a log file named diy.log in the folder where diya.exe was loaded from. Logging can also be enabled on start up using the Logging setting in the amlib.ini. This is useful when DIY is running as a service – for example: using FireDaemon.
APPENDICES

Appendix A: Amlib Database Connection Settings

As from version 5.1 Amlib Client/Server (and AmlibNet) will both use a single login on the RDBMS. In previous versions, each Amlib user had his or her own Login.

This has a number of advantages:

1. Ordinary users will not have knowledge of a database login that can be used outside Amlib
2. Amlib operator details can be added or altered without the need for an extra database login
3. The RDBMS will not become cluttered with logins, some of which may be obsolete
4. SQL Server’s new more restrictive login security requirements will not be a problem
5. Changing the logged in user in Amlib is now almost instantaneous

Configuration File

The amlib.ini file must now contain keys that specify the login name and password used by Amlib. These can be encrypted if required. The nopasswd.exe can be used to encrypt logins and passwords.

Sample Amlib configuration file settings using encryption:

```
[SPECIAL]
DatabaseUser=AMNET
DatabasePw=Y8X:4/Mpz49z%TTEn[91*367&|jia-{Sr-QE)gs2f@_Y91^6pSJ9'uzae]<a
```

Sample AmlibNet configuration file settings, not encrypted:

```
DatabaseUser=AMNET
DatabasePw=AMNET
```

Location of amlib.ini configuration file:

- **Amlib Windows Client:** [Windows] folder (for example: C:\Windows for Windows XP)
- **Amlib DIY Module:** [Windows] folder (for example: C:\Windows for Windows XP)
- **Amlib NetOpacs:** [Netopacs] folder (for example: C:\Netopacs)
- **AmlibNet:** AmlibNet application folder (for example: C:\Amlib\Amlibnet\bornet)

Passwords

User passwords will be stored in Amlib. The conversion script creates a password for each Amlib user that is the same as the User’s name – for example: A user called STAFF will have a password of STAFF. The password can be changed in Supervisor module (Main > Supervisor > UserNames).

Logins
The RDBMS login used by the application should have the db_owner role in each database in SQL Server and the appropriate rights on other platforms. If the login has the same settings as SYSADM it will work correctly.

Logins cannot be created from within Amlib. They must be created using the tools provided with the RDBMS. Scripts are available for the creation of a suitable login on SQL Server 2005.

Appendix B: Relationship between DIY Parameters and SIP2 Protocol

The Supervisor DIY Self Issue Parameters (see DIY Parameters above) are used to control the operation of the external devices communicating with the Amlib DIY Module using the 3M SIP2 protocol and the direct user interface mode.

The response packet numbers and their fields controlled by parameters for the SIP 2 mode are defined below:

- \(^1\) = Amlib DIY used as a Self-Service Application only
- \(^2\) = EnvisionWare
- \(^3\) = 3M

<table>
<thead>
<tr>
<th>Type</th>
<th>Comment</th>
<th>Reference No</th>
<th>PROCEED Y/N</th>
<th>System Message</th>
<th>3M SIP2 Protocol Response message/field</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>&gt; max on loan</td>
<td>1</td>
<td>N</td>
<td>You have exceeded the loan limits at this Library</td>
<td>If Proceed = N: 12 – ok = 0 and screen message = user message</td>
</tr>
</tbody>
</table>
| B     | Borrower has memo         | 2            | N           | Please call at the Service Desk as we have a message for you                  | If Proceed = N: 64 - BL = N
Summary Position 4 = Y and screen message = user message |
| B     | Borrower has overdues     | 3            | Y           | You have overdue items on Loan. Please call at the Service Desk              | If Proceed = N: 64 - BL = N
Summary Position 0,1 = YY and screen message = user message |
<p>| B     | Borrower owes money       | 4            | Y           | You have an outstanding account. Please call at the Service Desk              | If Proceed = Y: Check parameter B30 if amount owing is not zero |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
<td>Borrower reregister on expiry</td>
<td>5</td>
<td>N</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td><strong>Else:</strong></td>
<td>64 - BL = N</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summary Position 0,1 = YY and screen message = user message</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
<td>Borrower has expired</td>
<td>6</td>
<td>N</td>
<td>Your registration has expired. Please call at the Service Desk</td>
</tr>
<tr>
<td></td>
<td><strong>If Proceed</strong> = N:</td>
<td>64 - BL = N</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summary Position: 0,1 = YY and screen message = user message</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
<td>Borrower PIN No Required if Proceed = Y</td>
<td>7</td>
<td>N</td>
<td>Please enter your PIN number</td>
</tr>
<tr>
<td></td>
<td><strong>If PIN Valid:</strong></td>
<td>64 – CQ = Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Else:</strong></td>
<td>64 – CQ = N</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summary Position 0,1 = YY</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
<td>Log off password</td>
<td>8</td>
<td>Y</td>
<td>EXIT the first 8 chars are used for AMLIB DIY</td>
</tr>
<tr>
<td></td>
<td><strong>1 N/A</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
<td>Inactivity timeout</td>
<td>9</td>
<td>Y</td>
<td>120 the first 3 characters are seconds to return to Main Menu on Amlib DIY Module</td>
</tr>
<tr>
<td></td>
<td><strong>1 N/A</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
<td>Borrower group(s) with preceding hyphen</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>If Proceed = Y:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>List of permitted groups</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>If Proceed = N:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>List of prohibited groups</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>2</strong> Used to set internet access for EnvisionWare</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>64 - BL = N</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>2 64 – field PA is set to I (internet allowed) or NI (no internet allowed)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>3m Checkin</td>
<td>11</td>
<td>Y</td>
<td>Allow / Disallow returns from Device</td>
</tr>
<tr>
<td>B</td>
<td>3m Checkout</td>
<td>12</td>
<td>N</td>
<td>Allow / Disallow issues from Device</td>
</tr>
<tr>
<td>B</td>
<td>3m Renewals</td>
<td>13</td>
<td>Y</td>
<td>Allow / Disallow renewals from Device</td>
</tr>
<tr>
<td>B</td>
<td>3m Update status Process 01 Block Patron request</td>
<td>14</td>
<td>N</td>
<td>Update borrower status if instructed by device</td>
</tr>
<tr>
<td>B</td>
<td>3m Offline</td>
<td>15</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>B</td>
<td>Amlib version</td>
<td>16</td>
<td>Y</td>
<td>N/A</td>
</tr>
<tr>
<td>B</td>
<td>Institution Id</td>
<td>17</td>
<td>Y</td>
<td>Amlib Public Library</td>
</tr>
<tr>
<td>B</td>
<td>Library Name</td>
<td>18</td>
<td>Y</td>
<td>Inverness Rd Branch</td>
</tr>
<tr>
<td>B</td>
<td>Terminal Location</td>
<td>19</td>
<td>N</td>
<td>INV</td>
</tr>
<tr>
<td>B</td>
<td>3m Screen message</td>
<td>20</td>
<td>Y</td>
<td>Welcome to the Library</td>
</tr>
<tr>
<td>B</td>
<td>3m Print message</td>
<td>21</td>
<td>Y</td>
<td>Happy Christmas</td>
</tr>
<tr>
<td>B</td>
<td>3m Status Proceed</td>
<td>22</td>
<td>Y</td>
<td>ok</td>
</tr>
<tr>
<td>B</td>
<td>Amlib Main Image</td>
<td>23</td>
<td>Y</td>
<td>&lt;Path to image file&gt;</td>
</tr>
<tr>
<td>B</td>
<td>Amlib Borr Image</td>
<td>24</td>
<td>Y</td>
<td>&lt;Path to image file&gt;</td>
</tr>
<tr>
<td>B</td>
<td>Amlib Item Image</td>
<td>25</td>
<td>Y</td>
<td>&lt;Path to image file&gt;</td>
</tr>
<tr>
<td>B</td>
<td>Amlib Allow Print onloan</td>
<td>26</td>
<td>Y</td>
<td>Print All Items</td>
</tr>
<tr>
<td>B</td>
<td>Wand Barcode Desc</td>
<td>27</td>
<td>Y</td>
<td>Your Card Number should appear here</td>
</tr>
<tr>
<td>B</td>
<td>Amlib Allow Print new items</td>
<td>28</td>
<td>Y</td>
<td>Print New Items</td>
</tr>
<tr>
<td>B</td>
<td>Borrower button text</td>
<td>29</td>
<td>N</td>
<td>Please Press the Enter Key to Continue</td>
</tr>
<tr>
<td>B</td>
<td>Borrower fine limit – the 1st 4 digits are limit in cents</td>
<td>30</td>
<td>N</td>
<td>3100 Your Account has exceeded the allowed limit</td>
</tr>
</tbody>
</table>
### Allow renewals in Amlib

| B | Allow renewals in Amlib | 31 | Y | Allow renewals in Amlib without item | N/A for SIP2 |

### Amlib Invalid borrower barcode

| B | Amlib Invalid borrower barcode | 32 | N | The bar code just entered has a problem. Try again or ask a Staff member for Help | N/A for SIP2 |

### Borrower type(s) with preceding hyphen which are classed as ADULT

| B | Borrower type(s) with preceding hyphen which are classed as ADULT | 33 | Y | 64 – field ZY is set to ADULT |

### Borrower type(s) with preceding hyphen which are classed as CHILD

| B | Borrower type(s) with preceding hyphen which are classed as CHILD | 34 | Y | 64 – field ZY is set to CHILD |

#### 64 - BL = N if borrower type in list

### Stockitem (S)

<table>
<thead>
<tr>
<th>Type</th>
<th>Comment</th>
<th>Reference No</th>
<th>PROCEED Y/N</th>
<th>System Message</th>
<th>3M SIP2 Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Item already on loan</td>
<td>1</td>
<td>Y</td>
<td>This item may not be issued. Please take it to the Service Desk</td>
<td>If Proceed = N: 12 – ok = 0 and screen message = user message</td>
</tr>
<tr>
<td>S</td>
<td>Item has memo</td>
<td>2</td>
<td>N</td>
<td>This item may not be issued. Please take it to the Service Desk</td>
<td>If Proceed = N: 12 – ok = 0 and screen message = user message</td>
</tr>
<tr>
<td>S</td>
<td>Item has alert</td>
<td>3</td>
<td>N</td>
<td>This item may not be issued. Please take it to the Service Desk</td>
<td>If Proceed = N: 12 – ok = 0 and screen message = user message</td>
</tr>
<tr>
<td>S</td>
<td>Item has alien reserve</td>
<td>4</td>
<td>N</td>
<td>This item may not be issued. Please take it to the Service Desk</td>
<td>If Proceed = N: 12 – ok = 0 and screen message = user message</td>
</tr>
<tr>
<td>S</td>
<td>If Proceed = Y: Check for item charge on return and cancel</td>
<td>5</td>
<td>Y</td>
<td>Item charge cancelled</td>
<td>N/A for SIP2</td>
</tr>
<tr>
<td>S</td>
<td>Stop issue on charge</td>
<td>6</td>
<td>N</td>
<td>This item may not be issued. Please take it to the Service Desk</td>
<td></td>
</tr>
</tbody>
</table>
| S  | No loan allowed  | 7   | N   | You may not borrow this type of Item | If Proceed = N:  
12 – ok = 0 and screen message = user message |
|---|-----------------|-----|-----|--------------------------------------|--------------------------------------------------|
| S  | No renewal allowed  | 8   | N   | You may not renew this type of item  | If Proceed = N:  
12 – ok = 0 and screen message = user message |
| S  | Renewal limit exceeded  | 9   | N   | You have renewed this too often already | If Proceed = N:  
12 – ok = 0 and screen message = user message |
| S  | Item not for loan  | 10  | N   | This item may not be borrowed  | If Proceed = N:  
12 – ok = 0 |
| S  | Renew Overdue Item  | 11  | Y   | Item is overdue and may not be renewed  | If Proceed = N:  
12 – ok = 0 and screen message = user message |
| S  | Max Items Reached  | 12  | N   | You have too many items on loan already  | If Proceed = N:  
12 – ok = 0 and screen message = user message |
| S  | Exceeded Form Limit  | 13  | N   | You have too many items of that type on loan  | If Proceed = N:  
12 – ok = 0 and screen message = user message |
| S  | Magnetic media - Item form code(s) with preceding hyphen  | 14  | N   | If form in list and Proceed = Y:  
List of permitted form codes  
Desensitize = N  
Else:  
12 – magnetic media = Y  
Desensitize = N |
| S  | Magnetic media - Item form code(s) with preceding hyphen  | 15  | Y   | If form in list and Proceed = N:  
12 – magnetic media = Y  
Desensitize = N  
Else:  
12 – magnetic media = Y  
Desensitize = N |
<table>
<thead>
<tr>
<th>S</th>
<th>Items not to be removed from library – for example: Reference Item form code(s) with preceding hyphen</th>
<th>16</th>
<th>N</th>
<th>If form in list: 12 – Desensitize = N</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Default loan period</td>
<td>17</td>
<td>Y</td>
<td>-21 When offline allow this to be used as a default loan for display purposes</td>
</tr>
<tr>
<td>S</td>
<td>Amlib - Item button text</td>
<td>18</td>
<td>N</td>
<td>Process the next Item or Press Esc to Finish</td>
</tr>
<tr>
<td>S</td>
<td>Allow returns in Amlib</td>
<td>19</td>
<td>Y</td>
<td>Allow returns in Amlib</td>
</tr>
<tr>
<td>S</td>
<td>Amlib - Print return items list</td>
<td>20</td>
<td>Y</td>
<td>Print</td>
</tr>
<tr>
<td>S</td>
<td>Return reserved item</td>
<td>21</td>
<td>N</td>
<td>The returned item is on reserve to another borrower If Proceed = Y and item reserved: 10 – alert = Y and screen message = user message</td>
</tr>
</tbody>
</table>
Appendix C: SIP/SIP2 Packets Supported by Vendor Type

3M Self Check

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 97 – Request ACS Resend</td>
<td>• 263 – Patron Information</td>
</tr>
<tr>
<td>• 99 – SC Status</td>
<td>• 35 – End Patron Session</td>
</tr>
<tr>
<td>• 23 – Patron Status Request</td>
<td>• 17 – Item Information</td>
</tr>
<tr>
<td>• 01 – Block Patron</td>
<td>• 29 – Renew</td>
</tr>
<tr>
<td>• 11 – Checkout</td>
<td>• 65 – Renew All</td>
</tr>
<tr>
<td>• 109 – Checkin</td>
<td>• 37 – Fee Paid</td>
</tr>
</tbody>
</table>

1SIP2 Extensions are used in the response packet:

- CV field – Alert type

The following alerts are checked for:

<table>
<thead>
<tr>
<th>VALUE</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 01</td>
<td>hold for this library</td>
</tr>
<tr>
<td>• 02</td>
<td>hold for other branch</td>
</tr>
<tr>
<td>• 03</td>
<td>send to other branch</td>
</tr>
</tbody>
</table>

- CT field – Destination Location
- CY Field – Hold Patron ID
- DA Field – Hold Patron Name

2Special processing is used in the response packet:

- Check Borrower Type against the list in parameter B34. If found set the Valid Patron flag to N and screen message to 'Not a permitted Borrower Type'
TalkingTech iTiva

<table>
<thead>
<tr>
<th></th>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>97 – Request ACS Resend</td>
<td></td>
</tr>
<tr>
<td></td>
<td>99 – SC Status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>01 – Block Patron</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>63 – Patron Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>35 – End Patron Session</td>
<td></td>
</tr>
<tr>
<td></td>
<td>17 – Item Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>29 – Renew</td>
<td></td>
</tr>
<tr>
<td></td>
<td>65 – Renew All</td>
<td></td>
</tr>
<tr>
<td></td>
<td>15 – Hold</td>
<td></td>
</tr>
</tbody>
</table>

STi LogiTrack RFID

**No packet checksum is generated for this device.

<table>
<thead>
<tr>
<th></th>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>97 – Request ACS Resend</td>
<td></td>
</tr>
<tr>
<td></td>
<td>99 – SC Status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>23 – Patron Status Request</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 – Checkout</td>
<td></td>
</tr>
<tr>
<td></td>
<td>09 – Checkin</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>63 – Patron Information</td>
<td></td>
</tr>
</tbody>
</table>

EnvisionWare

<table>
<thead>
<tr>
<th></th>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>97 – Request ACS Resend</td>
<td></td>
</tr>
<tr>
<td></td>
<td>99 – SC Status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>23 – Patron Status Request</td>
<td></td>
</tr>
<tr>
<td></td>
<td>01 – Block Patron</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 – Checkout</td>
<td></td>
</tr>
<tr>
<td></td>
<td>09 – Checkin</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>63 – Patron Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>35 – End Patron Session</td>
<td></td>
</tr>
<tr>
<td></td>
<td>17 – Item Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>29 – Renew</td>
<td></td>
</tr>
<tr>
<td></td>
<td>65 – Renew All</td>
<td></td>
</tr>
<tr>
<td></td>
<td>37 – Fee Paid</td>
<td></td>
</tr>
</tbody>
</table>

^Special fields or formatting are used in the response packet:

Non standard fields:

- **ZY** field – Using Borrower type (either **ADULT** or **CHILD** or no **ZY** field)
- **PA** field - Internet access using Borrower group (I = Internet OK / NI = No Internet)
Non standard format in fields:

- **AT** field – Overdue items:
  - Item Barcode <space> Item due date <space> Issuing location <space> $0.00 <space> Item title

- **AV** field – Fine/Fees:
  - Transaction id <space> $Fine amount <space> Fine type <space> Item title/comments

- **AS** field – Available Hold items:
  - Item Barcode <space> Reserve location <space> Reserve Date <space> $0.00 <space> Item title

- **CD** field – Unavailable Hold items:
  - Item Barcode <space> Reserve location <space> Reserve Date <space> $0.00 <space> Item title

^2 SIP2 Extensions are used in the response packet:

- **CV** Field – Alert type

  The following alerts are checked for:

<table>
<thead>
<tr>
<th>VALUE</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>hold for this library</td>
</tr>
<tr>
<td>02</td>
<td>hold for other branch</td>
</tr>
<tr>
<td>04</td>
<td>send to other branch</td>
</tr>
</tbody>
</table>

- **CT** field – Destination Location

- **CY** Field – Hold Patron ID

- **DA** Field – Hold Patron Name
SmartLibrary

<table>
<thead>
<tr>
<th>SIP</th>
<th>SIP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>97 – Request ACS Resend</td>
<td>63 – Patron Information</td>
</tr>
<tr>
<td>99 – SC Status</td>
<td>35 – End Patron Session</td>
</tr>
<tr>
<td>23 – Patron Status Request</td>
<td>117 – Item Information</td>
</tr>
<tr>
<td>01 – Block Patron</td>
<td>29 – Renew</td>
</tr>
<tr>
<td>11 – Checkout</td>
<td>65 – Renew All</td>
</tr>
<tr>
<td>209 – Checkin</td>
<td></td>
</tr>
</tbody>
</table>

1Special fields or formatting are used in the response packet:

Non standard fields:

- CR field – Item collection code
- CS field – Item Call Number

The fields are separated by a ^ character

2SIP2 Extensions are used in the response packet:

- CR field – Item collection code
- CS field – Item Call Number
- CT field – Destination Location
- CV Field – Alert type

The following alerts are checked for:

<table>
<thead>
<tr>
<th>VALUE</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>02</td>
<td>hold for this library</td>
</tr>
<tr>
<td>02</td>
<td>hold for other branch</td>
</tr>
</tbody>
</table>

- CY Field – Hold Patron ID
- DA Field – Hold Patron Name